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E-formas izveides plūsma sastāv no trim daļām:
· VRAA pievieno iestādi;
· iestāde, izveidojot e-formu;
· VRAA, norādot datus par e-formu to publicē. 
Lai iestādes varētu sākt veidot un publicēt savas e-formas, VRAA e-formu publicētājam ir jāpievieno jaunu iestādi “E-formu katalogā”.
[bookmark: _Ref38292953][bookmark: _Toc69985597]Iestādes pievienošana E-formu katalogā 

Lai izveidotu jaunu iestādi, VRAA e-formu publicētājam jāizvēlas sadaļa “Content Editor”. Atvērsies Sitecore “Home” sadaļa, kur varēs pievienot jaunu iestādi. 
[image: tempsnip]
1. att. VRAA e-formu publicētāja galvenais logs
“Home” sadaļā būs pieejams “E-formu katalogs”, lai pievienotu jaunu iestādi jānospiež E-formu katalogs->Insert->E-form authority. Tiks izveidota jaunās iestādes mape, kurai būs jāpiešķir nosaukums.  [image: ]
1. att. Jaunas iestādes pievienošana E-formu katalogam 

E-formu katalogā, norādot jaunās iestādes nosaukumu, jānorāda iestādes īso nosaukumu. Īso nosaukumu vēlams kopēt no Authority klasifikatora. Nosaukums tiks izmantots arī kā daļa no e-formas hipersaites. 
Norādot mapes nosaukumu, netiek izmantoti speciālie simboli (@,#,$,%,^ utt.), bet var tikt izmantotas atstarpes vai apakšsvītras “_”, lai atdalītu vārdus nosaukumā. Kad nosaukums tiek izveidots, jānospiež poga “OK”, lai tiktu izveidota jauna iestādes mape.
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att. Kataloga kartiņa norāda iestādes nosaukumu 
[bookmark: _Ref50652680][bookmark: _Toc69985598]Aizpilda E-formas kataloga kartītes metadatus par iestādi
Izveidojot jaunu iestādi, nepieciešams aizpildīt datus. Nospiežot uz izveidotās mapes “VARAM_VVD”, parādīsies sadaļa “Iestādes dati”.
Sadaļā iestādes dati jānorāda informācija par iestādi:
· Nosaukums – Iestādes pilnais nosaukums;
· Kods – Authority ID – Iestādes kods/ID ar kādu iestāde reģistrēta VISS portālā;
· Reģ. Nr. – Juridiskās personas reģistrācijas numurs.
Pārējā informācija jāatstāj pēc noklusējuma. 
Ievadītā informācija jāsaglabā, nospiežot “Save” pogu “Home” sadaļā.
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att. Kataloga kartītē norāda iestādes metadatus
Pēc saglabāšanas izveidojas iestādes mape “Forms” sadaļā. Lai pārliecinātos, ka iestādes mape tika izveidota, nepieciešams izpildīt punktus, kuri aprakstīti nodaļā 4. E-formas pārvaldība.
Ja ir paredzēts, ka iestādei būs nepieciešamas formas citās valodās, tad labajā stūrī spiež uz valodas izvēlnes.
[image: ]
att. Valodas nomaiņa iestādei
Tiek atvērts jauns logs, ar iespēju pievienot jaunu versiju valodai. Spiež “Add a new version.”
[image: ]
att. Jaunas valodas versijas izveidošana
Tālāk, lai sāktu rediģēšanu, spiež “Lock and Edit”.
[image: ]
att.  Rediģēšanas atbloķēšana

Sadaļā iestādes dati atkārtoti norāda informāciju par iestādi:
· Nosaukums – Iestādes pilnais nosaukums;
· Kods – Authority ID – Iestādes kods/ID ar kādu iestāde reģistrēta VISS portālā;
· Reģ. Nr. – Juridiskās personas reģistrācijas numurs.
Un ievadīto informāciju saglabā, nospiežot “Save” pogu “Home” sadaļā.
Iestādei ir pievienota jauna valodas versijas un to var apskatīt, nospiežot valodu pogu. 
[image: ]
Att. Valodu versijas 
[bookmark: _Toc69985599]E-formas izveide no iestādes profila 

Iestādes e-formu veidotājam ir tiesības izveidot jaunu e-formu. Jaunas e-formas izveide iespējama divos veidos – veidojot pilnīgi jaunu e-formu vai saglabājot publiski pieejamo e-formu ar “Save as” un izmantot to kā sagatavi (aprakstīts 7 nodaļā Publiski pieejamās e-formas). 
[bookmark: _Toc69985600]E-formas mapes izveide
Pirms jaunās e-formas izveides Iestādes e-formu veidotājam ir nepieciešams izveidot e-formas mapi. E-formas mapes izveide ir nepieciešama, jo, veidojot jauno e-formu, to var saglabāt tikai iestādes privātajā mapē. 
Lai pievienotu jaunu mapi, Iestādes e-formu veidotājam jāizvēlas sadaļa “Content Editor”. Atvērsies “Home” sadaļa, kurā būs pieejama iestādes mape. 
[image: tempsnip]
att. Iestādes e-formas veidotāja galvenais logs
“Home” sadaļā, lai izveidotu jaunu e-formas mapi, jānospiež Forms->VARAM_VVD (iestādes mape)->to_publish->Insert->Folder. Tiks izveidota jauna mape iekš “to_publish”, kurai būs nepieciešams norādīt nosaukumu. 
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att. E-formas mapes izveide
Norādot mapes nosaukumu, netiek izmantoti speciālie simboli (@,#,$,%,^ utt.), bet var tikt izmantotas atstarpes vai apakšsvītras “_”, lai atdalītu vārdus nosaukumā. Kad nosaukums tiek izveidots, jānospiež poga “OK”, lai tiktu izveidota jauna e-formas mape. Mapes nosaukuma piemērs “vvd_application”.
[image: ]
att. Norāda e-formas mapes nosaukumu
[bookmark: _Toc69985601]E-formas izveidošana
Iestādes e-formu veidotājs var izveidot pilnīgi jaunu e-formu. Ja paredzēts veidot e-formu gan fiziskai, gan juridiskai personai, tad ir jāveido divas atsevišķas e-formas – viena priekš fiziskām personām un otra priekš juridiskām personām. Lai sāktu veidot e-formas, jāizvēlas sadaļa “Forms”. Atvērsies “Forms” sadaļa, kur būs pieejamas visas iepriekš izveidotās e-formas, visas publiskās e-formas, kā arī varēs izveidot jaunu e-formu.  
[image: tempsnip]
att. Iestādes e-formas veidotāja galvenais logs

Pirms sāk veidot jaunu e-formu augšējā izvēlnē norāda vēlamo valodu (latviešu, angļu vai krievu). 
[image: ]
att. Valodas norādīšana
Lai uzsāktu jaunas e-formas veidošanu, nospiež Create->Blank form. 
[image: ]
att. Jaunas e-formas izveide

Atvērsies e-forma ar iespēju pievienot dažādus elementus. Sadaļā “Design” ir iespējams pievienot gan standarta Sitecore elementus, gan Latvija.lv profila datus. 
No Sitecore standarta elementiem var pievienot laukus: 
· Text - lauks, kurš paredzēts informatīva teksta, piemēram, “Iesniegums” ievadei;
· Single-line text - lauks, kurš paredzēts īsu vārdu vai frāžu ievadīšanai;
· Multiple-line text - lauks, kurš paredzēts garāku tekstu ievadei. Nav ierobežots simbolu skaits;
· Number – lauks, kurā var izvēlēties ciparu; 
· Email – lauks, kurš paredzēts e-pasta ievadei;
· Telephone – lauks, kurš paredzēts telefona numura ievadei;
· Checkbox – izvēles rūtiņa;
· Date – lauks, kurš paredzēts datuma ievadei;
· Table – tabulas izveidošana;
· Dropdown list – ļauj izvēlēties vienu vērtību no saraksta. Ja saraksts ir neaktīvs, tas parāda vienu vērtību. Ja saraksts ir aktīvs, tad tiek parādīts (izkrītošs) vērtību saraksts, no kura lietotājs var izvēlēties vienu vērtību. Saraksta aizpildei var izmantot statisko vai dinamisko sarakstu;
· List box – ļauj lietotājam izvēlēties vienu vai vairākus vienumus no statiska vai dinamiska saraksta (papildus informācija ir pieejama pēc linka https://doc.sitecore.com/users/100/sitecore-experience-platform/en/add-list-items-for-forms.html);
· Checkbox list – dot iespēju atzīmēt vairākus atbilžu variantus no pieejamā saraksta. Saraksta aizpildei var izmantot statisko vai dinamisko sarakstu (Piemēru par elementa izvietošanu vairākās rindās un kolonnās skatīt 3.3 sadaļā);
· Radio button list – var atzīmēt tikai vienu variantu no pieejamā saraksta. Saraksta aizpildei var izmantot statisko vai dinamisko sarakstu;
· Section - atdala elementus, ļaujot nostilot elementu izkārtojumu formā;
· Submit button – saglabāšanas poga nepieciešama, lai lietotāji latvija.lv varētu aizpildīto e-formu iesniegt. Pēc iesniegšanas e-formas dati tiks saglabāti un e-forma tiks pievienota ziņojumam. Šo pogu obligāti jāpievieno veidojot e-formu, ieteicams novietot e-formas beigās;
· Cancel button – atcelšanas poga nepieciešama, lai lietotāji latvija.lv varētu atcelt e-formas aizpildīšanu. Atceļot e-formas aizpildi, e-formā aizpildītā informācija netiks saglabāta un lietotājs tiks atgriezts ziņojuma rakstīšanas formā. Šo pogu obligāti jāpievieno veidojot e-formu, ieteicams novietot e-formas beigās.
No Latvija.lv var pievienot laukus: 
· Autorizētās personas vārds – aizpildot formu tiks automātiski aizpildīts ar autorizētās personas vārdu,  aizpildītais lauks nav labojams;
· Autorizētās personas uzvārds – aizpildot formu tiks automātiski aizpildīts ar autorizētās personas uzvārdu, aizpildītais lauks nav labojams;
· Autorizētās personas personas kods – aizpildot formu tiks aizpildīts ar autorizētās personas personas kodu, aizpildītais lauks nav labojams;
· Juridiskās personas nosaukums – aizpildās ar juridiskās personas nosaukumu no autorizācijas datiem, aizpildītais lauks nav labojams;
· Juridiskās personas reģistrācijas numurs – aizpildās ar juridiskās personas reģistrācijas numuru no autorizācijas datiem, aizpildītais lauks nav labojams.
Papildus dati no Latvija.lv lietotāju profila, kurus iespējams labot:
· Bankas konts – aizpildās ar lietotāja profilā norādīto bankas kontu, iespējams rediģēt;
· E-pasts – aizpildās ar lietotāja profilā norādīto e-pasta adresi, iespējams rediģēt;
· Adrese – aizpildās ar lietotāja profilā norādīto kontaktadresi, iespējams rediģēt;
· Tālruņa numurs – aizpildās ar lietotāja profilā norādīto tālruņa numuru, iespējams rediģēt.
Papildus katram elementam ir pieejama šāda funkcionalitāte: 
· “Styling” - var pievienot papildus stilu veidotajai e-formai un tās elementiem (sīkāks skaidrojums pieejams pēc linka https://doc.sitecore.com/users/100/sitecore-experience-platform/en/change-the-styling-of-a-form.html). Lai noteiktu jaunveidojamās formas elemntu izvietojumu, kā piemēru skatīt eFormu Public Forms mapē esošo formu “form-examples”;
· “Conditions” - var definēt papildus nosacījumus laukiem (sīkāks skaidrojums pieejams pēc linka https://doc.sitecore.com/developers/100/sitecore-experience-manager/en/use-conditional-logic-for-your-forms.html vai piemērs 3.3 sadaļā);
· “Validation” – var pievienot laukiem ievades nosacījumus, vai lauks ir obligāti aizpildāms, vai neobligāti;
· “Advanced seting” – papildus sitecore iebūvētie nosacījumi par datu glabāšanu un noklusētajām vērtībām. 

Detalizēta informācija par e-formas vizuālā izkārtojuma noformēšanu, elementu funkcionalitāti un portāla stila izmantošanu aprakstīts 3.3 sadaļā.
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att. E-formas lauku pievienošana
Ja ir nepieciešams izdzēst lauku, tad jāatzīmē nepieciešamais lauks un jānospiež poga ar sarkanu krustiņu (skat. 16. att.).
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att. Elementa dzēšana

Pēc e-formas izveides tā ir jāsaglabā, nospiežot pogu “Save”, parādīsies lauks “Name”, kur jānorāda e-formas nosaukumu. Nosaukumā netiek izmantoti speciālie simboli (@,#,$,%,^ utt.), bet var tikt izmantotas atstarpes vai apakšsvītras “_”, lai atdalītu vārdus nosaukumā.
E-formas nosaukuma piemērs “application”.
Blokā “Location:”, jānorāda mape, kurā e-forma tiks saglabāta un tad jānospiež poga “Save”.
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att. E-formas saglabāšana iestādes E-formas mapē

Katrai valodai ir jāsaglabā jauna e-forma. Lai izveidotu e-formu citās valodās, nomaina valodu augšējā rīkjoslā. 
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att. E-formas valodas nomaiņa 
Pēc valodas nomaiņas pārliecinās, vai elementi, pogas un tabulu kolonnu nosaukumi ir vēlamajā valodā, ja nav, tad nomaina. 
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att. Elementu un pogu nosaukumi
Kad e-forma pabeigta un nosaukumi nomainīti, spiež pogu “Save”.
[image: ]
att. E-formas saglabāšana
Spiež pogu “Back” un pārliecinās, ka Forms sadaļā ir izveidota e-formas vēlamajās valodās.
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att. Izveidotas e-formas.
E-forma būs pieejama Latvija.lv portālā pārslēdzoties uz attiecīgo valodu.
Kad e-formu veidošana pabeigta, iestāde paziņo VRAA e-formu publicētājam, ka e-forma/s ir gatava/s un to/ās nepieciešams publicēt.

[bookmark: _Ref54251714][bookmark: _Toc69985602]E-formas elementu funkcionalitāte un izkārtojuma noformēšana
[bookmark: _Toc69985603]“Section” elementa izmantošanas piemērs.
Lai e-formu sadalītu sekcijās, izmanto elementu “Section”. Tas palīdz grupēt elementus, strukturēt veidlapu un novietot objektus blakus viens otram vai jaunā rindā. 
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att. Sekcijas izmantošanas paraugs
Piemēram, lai noformētu 3 izvēlnes rūtiņas ar pavadošo tekstu “Lūdzu izsniegt izziņu par:” kā 22. attēlā, izveido 1 kopējo sekciju un zem “Styling” pievieno CSS klases: row mx-0  mt-4 justify-content-end px-3 col-md-12 
Visām sekcijām un jaunajiem elementiem norāda nosaukumus pie Field name. Piemēram: Section1234.
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att. Kopējās sekcijas izveidošana
Pirmajā sekcijā ievieto jaunu sekciju un elementu Text. Sekcijai pievieno CSS klasi: col-md-7 mx-0 px-0
Text elementam pievieno CSS klasi: col-md-offset-1 col-md-3 mx-0 font-size-s font-weight-bold
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att. Papilsekciju un teksta pievienošana
Tālāk izveidotajā sekcijā ievieto 3 jaunas sekcijas un katrā no tām ievieto Checkbox elementus.
Katrai sekcijai norāda CSS klasi: row col-md-12 mx-0 px-0
Checkbox elementam norāda CSS klasi: form-check-input un pie “CSS class for label” norāda: form-check-label col-md-12 px-0 mx-0
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att. Sekciju izveidošana katrai izvēlnes rūtiņai
Kad CSS klases pievienotas sekcijai ar “Field name”: Section1234 apakšā pievieno jaunu sekciju, kurai pievieno sekojošu klasi: col-md-1 ,kas izlīdzinās elementus.
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att. Apakšejās sekcijas pievienošana
Ievada Checkbox elementu nosaukumus un saglabā e-formu. 
[bookmark: _Toc69985604] “Condition” funkcionalitātes izmantošanas piemērs

Lai pievienotu nosacījuma funkcionalitāti, formas elementu sadaļā zem “Conditions” spiež uz “Edit Conditions”.
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att. “Condition” funkcionalitātes atvēršana
Tiek atvērts tukšs dialoglogs, kurā spiež uz “Add condition”, lai pievienotu nosacījumu. 
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att. “Conditions” dialoglogs
Tālāk nepieciešams norādīt elementus un pievienot atbilstošos nosacījumus. 
Piemēram, ja ir nepieciešams nosacījums, ka ja lietotājam ir vairāk par 1 bērnu ģimenē, tad ir nepieciešams ievadīt bērnu skaitu. Ja “Bērnu skaits” ir “Viens”, tad lauks “Lūdzu ievadiet bērnu skaitu” nebūs pieejams aizpildīšanai. Lai to izdarītu, aizpilda IF un THEN laukus.
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att. “Conditions” nosacījumu izveidošana
Atkarībā no izvēlētiem elementiem, pieejamās opcijas nolaižamajā sarakstā var atšķirties. Var tikt pievienotas vairākas darbības dažādiem mērķa laukiem vienā nosacījumu grupā, lai to izdarītu, jānospiež “Add Condition”. 
Lai saglabātu izveidotos “if-then” nosacījumus, spiež “OK”. Izveidotais nosacījums tiks attēlots formas elementu sadaļā.
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att. Izveidotā nosacījumu attēlošana formas elementu sadaļā
[bookmark: _Toc69985605]Atdalošās līnijas piemērs

Atdalošai līnijai izmanto sekcijas elementu(Section) un zem “Styling” iekopē CSS klasi: col-md-12 email__description. 
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att. Atdalošās līnijas piemērs
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att. Atdalošās līnijas paraugs
[bookmark: _Toc69985606]“Checkbox List” izvietošana vairākās rindās un kolonnās. 

Lai izvietotu izvēles rūtiņu saraksta elementus vairākās rindās un kolonnās, sākumā izveido galveno sekciju, kurā ievietos pārējās sekcijas un pievieno CSS klasi: row col-12
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att. Galvenās sekcijas izveidošana
Kad sekcija izveidota, tajā ievieto trīs sekcijas, kurām norāda sekojošas CSS klases:
col-2 d-flex my-4 justify-content-start
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att. Papildu sekciju pievienošana
Pēc tam katrā sekcijā ievieto pa vēl vienai sekcijai, kurām katrai norāda klasi: d-flex flex-column
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att. Sekciju izveidošana Checkbox elementiem
Kad sekcijas pievienotas, katrā ievieto Checkbox elementus pēc nepieciešamības, kuriem norāda “CSS class for label”: ml-2.
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att. Checkbox elementu pievienošana
Ievada Checkbox elementu nosaukumus un saglabā e-formu. 
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att. “Checkbox List” elementa izvietošanas paraugs
Elementu izvietošanu nav ieteicams izmantot e-formām, kurām paredzēta aizpildīšana no mobilām ierīcēm.
[bookmark: _Toc69985607]Ievadlauku elementa izvietošana tekstā

Lai izveidotu tekstu, kurā ir ievietoti ievadlauki, piemēram, lai ievadītu gadskaitli, izveido sekciju, kurā ievieto Text elementu. Sekcijai norāda klasi: col-md-12 d-flex un Text elemetam: mr-1
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Att. Sekcijas un teksta elementa pievienošana
Lai tekstā ievietotu ievadlaukus, var izmantot Single-line text elementu, kuram norāda CSS klasi: 
col-1 form-control input-sm un izdzēš Label.
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att. Ievadlauku pievienošana tekstam
Ja nepieciešams teksta turpinājums ievadlaukam, pievieno Text elementu, kuram norāda CSS klasi: mr-1
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att. Teksta turpinājuma pievienošana
Ja pēc teksta nepieciešams vēl viens ievadlauks, atkal izvēlas Single-Line Text elementu, kuram izdzēš Label un norāda CSS klasi: col-1 form-control input-sm mr-1
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att. Ievadlauku pievienošana turpinājuma tekstam
Pēc ievadlauka var turpināt tekstu, atkārtoti izvēloties Text elementu.
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Att. Papildus teksta pievienošana ievadlaukam
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att. Paraugs ievadlauku izvietošanai tekstā
Elementu nav ieteicams izmantot e-formām, kurām paredzēta aizpildīšana no mobilām ierīcēm.
[bookmark: _Toc69985608][bookmark: _Ref69985728]Tabulas nosaukumu formēšana

Tabulu kolonnas un rindas var aizpildīt ar predefinētām nemainīgām vērtībām, ļaujot realizēt tabulas, kurām ir predefinēti tikai kolonnu nosaukumi vai tikai rindas nosaukumi, vai predefinēti gan kolonnu, gan rindas nosaukumi. Tabulas šūnu ievadi veic formātā:
[rindas numurs, kolonnas numurs] šūnas vērtība.
Piemērs, ja nepieciešams aizpildīt gan pirmo kolonnu, gan pirmo rindu ar predefinētiem nosaukumiem, norāda rindu “Row count” un kolonnu “Columns” skaitu. Nospiežot “Apply”, parādīsies tabulas priekšskats lapā.
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att. Tabulas rindu un kolonnu skaita norādīšana.
Tālāk attiecīgi skaitam, pievieno “”filled cell” šūnas. Piemēram, ja ir 3 kolonnas un 2 rindas, kurām nepieciešams ievadīt nosaukumu, pievieno 5 (3+2) ievadlaukus, spiežot “Add New”. 
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att. Šūnu ievadlauka pievienošana
Tālāk aizpilda šūnu ievadlaukus ar nosaukumiem pēc principa [rindas numurs, kolonnas numurs] šūnas vērtība.
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att. Šūnu ievadlauku vērtību norādīšana
Iegūst sekojošu tabulu.
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att. Tabula ar predefinētām nemainīgām vērtībām

SVARĪGI! Pievienojot jaunu šūnu aizpildes ievadlauku “filled cell”, jāpievieno klāt attiecīgs kolonnu vai rindu skaits pie “Row Count” vai “Columns”! 

Piemērs, lietotājs pievienoja jaunu “filled cell”, kuru tabulā vēlas attēlot zem rindas [3,1] Summa.
Secība priekš “filled cell” nav svarīga, jo tāpat tiek norādīts rindas un kolonnas numurs, taču pārskatāmībai ir ieteicams ievērot šo secību. 
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att. Jaunas šūnas pievienošana
Aizpilda “filled cell” ar vērtību [4,1] Summa ar PVN.
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att. Jaunas šūnas aizpildīšana
Kad tas izdarīts, obligāti pie “Row Count” norāda rindu skaitu, kādu attēlot tabulā. Šai gadījumā tas ir 4. Pretējā gadījumā rinda tabulā neattēlosies, jo tabulas iestatījumos ir norādītas 3 rindas.
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att. Rindas skaita norādīšana
Spiež “Apply” un tabula ir gatava. 
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att. Tabula ar predefinētām rindas un kolonnu vērtībām
Ja tiek izdzēsta vērtība pa vidu, piemēram, rinda [3,1] Summa, paliek tukša rinda.
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att. Šūnu dzēšana
Šai gadījumā var pievienot jaunu “filled cell” vai pārsaukt [4,1] Summa ar PVN par [3,1] Summa ar PVN. 
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att. Šūnu aizpildīšana, pārsaucot rindas numuru
Ja nav paredzēts 4 rindu aizpildīt, samazina rindu skaitu “Row Count” uz atbilstošu vērtību. Šai gadījumā tas būs 3. 
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att. Rindas skaita norādīšana
Elementu nav ieteicams izmantot e-formām, kurām paredzēta aizpildīšana no mobilām ierīcēm.
[bookmark: _Toc69985609]Portāla stila izmantošanas piemērs

Lai formatētu elementus atbilstoši portāla stilam pēc LVP dizaina vadlīnijām, e-formas elementu sadaļā zem “Styling” nepieciešams norādīt CSS klases. 
Piemēram, lai izveidotu portāla stilu “Saglabāt” pogas elementam pie CSS klases iekopē: sm btn btn-default btn-rounded
“Atcelt pogai”: btn btn-danger btn-rounded btn-md
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att. Pogas formatēšana atbilstoši portāla stilam
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att. Atbilstoši portāla stilam formatētu pogu paraugs 
LVP dizaina vadlīnijas pieejamas vadlīniju dokumentā E-pakalpojumu vizuālā izskata ievērošanas vadlīnijas [7] un EservicePlatform.Controls.React 
Saite uz ietvara aprakstu: https://viss.gov.lv/lv/Informacijai/Dokumentacija/Koplietosanas_komponentes/EPAK_izstrades_izpildes_vide
Saite uz SDK: https://eservices-test.vraa.gov.lv/EservicePlatform.Controls.React/
[bookmark: _Toc54259426][bookmark: _Toc54347351][bookmark: _Toc50707452][bookmark: _Toc50716571][bookmark: _Toc50707453][bookmark: _Toc50716572][bookmark: _Toc46480525][bookmark: _Toc69985610]E-formas pārvaldība
Kad e-forma tiek izveidota un ir gatava publicēšanai, VRAA e-formu publicētājs var pārbaudīt e-formu un nepieciešamības gadījumā var labot to – mainīt lauku garumus, nosaukumus, dzēst vai pievienot e-formas elementus, par izmaiņām informējot iestādes e-formu veidotāju.
Lai varētu pārbaudīt, kādi lauki tiek izmantoti, vai nav kļūdu, jāizvēlas sadaļu NAVIGATE-> Open. Atvērsies logs “Insert Item”. 
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[bookmark: _Ref47093686]att. Sitecore navigācijas maiņa

Lai pārvaldītu iestādes izveidotās e-formas, jāizvēlas “Forms” un jānospiež poga “Insert”. Tiks attēlotas visas iestādes mapes un to veidotās e-formas. 
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[bookmark: _Ref47093701]att. E-formu pārvaldības sadaļa
VRAA e-formu publicētājs, nospiežot uz kāda e-formas elementa, var redzēt informāciju par to, kā arī var mainīt lauka parametrus.  
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att. E-formas elementu pārbaude


Nepieciešamības gadījumā, VRAA e-formu publicētājs var pievienot jaunus laukus. Lai pievienotu jaunu lauku e-formai, nepieciešams nospiest VARAM_VVD (iestādes mape)->published->vvd_application(e-formas mape)->v1-0(versijas mape)->application(e-forma)->page-> Insert. 
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att. E-formas elementu pievienošana

  
[bookmark: _Toc69985611]E-formu versionēšana un sagatavošana publicēšanai 
E-formu versionēšanu un sagatavošanu publicēšanai veic VRAA e-formu publicētājs. Versionēšana tiek nodrošināta ar mapju struktūru. 

Lai izveidotu formas mapi “published” mapē, jānospiež VARAM_VVD(iestādes mape)->published->Insert->Folder. Parādīsies logs, kurā jāievada formas mapes nosaukums. Kad nosaukums tiek ievadīts, jānospiež poga “OK”.
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att. Formas mapes izveidošana published mapē
Tālāk nepieciešams formas mapē izveidot versijas mapi “v1-0”, uz kuru pēc tam tiks pārvietota publicējamā e-forma. Lai izveidotu versijas mapi, jānospiež VARAM_VVD(iestādes mape)->published->vvd_application(formas mape)->Insert->Folder. Parādīsies logs, kurā jāievada versijas mapes nosaukums. 
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att.  E-formas versijas mapes izveide 



Ievada versijas mapes nosaukumu un nospiež pogu “OK”.
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att. Versijas mapes nosaukums
Lai pārnestu e-formu no “to_publish” uz “published” versijas mapi, jānospiež VARAM_VVD(iestādes mape)->to_publish->vvd_application (e-formas mape)->application (e-forma)->Copying->Move To -> published -> Formas mape -> versijas mape. 
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att. E-formas mape









Publicējamo e-formu var atrast: Sitecore->Forms->VARAM_VVD(iestādes mape)->published->vvd_application(e-formas mape)->v1-0(versijas mape)->application(e-forma). 
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att. Publicējamā e-forma

[bookmark: _Toc69985612]E-formas kataloga kartītes izveide

E-formas kataloga kartīti var pievienot VRAA e-formu publicētājs. E-formas kartīte ir nepieciešama, jo tā norāda saiti uz publicējamo e-formu no iestādes mapes “published” un attiecīgās versijas apakšmapes, kā arī satur informāciju par e-formas nosaukumu, tematu, saturu un nepieciešamajām papildus pazīmēm, kuras piemīt e-formai.
[bookmark: _Toc69985613]E-formas kartītes pievienošana E-formu katalogā
Piemēram, iestādei “VARAM_VVD” pievieno E-formas kataloga kartīti. Lai pievienotu kartīti, “Home” sadaļā jānospiež uz iestādes mapes un jāpievieno jauna kartīte, tas ir, VARAM_VVD->Insert->E-form. 
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att. E-formas kataloga kartītes pievienošana
Izveidojam E-formas kataloga kartītes ierakstu, norādot E-formas nosaukumu. Nosaukums tiks izmantots e-formas hipersaitē. Norādot kartītes nosaukumu, netiek izmantoti speciālie simboli (@,#,$,%,^ utt.) bet var tikt izmantotas atstarpes vai apakšsvītras “_”, lai atdalītu vārdus nosaukumā. Kad nosaukums tiek izveidots, jānospiež poga “OK”, lai tiek izveidota jauna kartīte.
E-formas kataloga kartītes nosaukuma piemērs “003_application”.
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att. E-formas nosaukums

[bookmark: _Toc69985614]E-formas kataloga kartītes metadatu aizpildīšana
Nospiežot uz mapes “VARAM_VVD”, parādīsies  “003_application”.
Jāaizpilda E-formas metadati:
· URN – vērtība tiek ģenerēta automātiski;
· Nosaukums – e-formas nosaukums, kas tiks attēlots e-adreses ziņojumā;
· Temats – tiks attēlots e-adreses laukā “Temats” (maksimālais simbolu skaits: 200);
· Teksts – tiks attēlots e-adreses ziņojuma satura lauka vietā (maksimālais simbolu skaits: 4000);
· E-adrese – e-adrese, uz kuru tiks nosūtīts aizpildītais e-formas ziņojums;
· Stāvoklis – jāizvēlas “Published” (e-forma ir publicēta) vai “Not published” (e-forma nav publicēta).
Var atzīmēt papildus pazīmes:
· Mobilais skats – pazīme, vai e-forma pieejama mobilajā skatā; 
· Datņu pievienošana – pazīme, vai izveidotajam e-formas e-adreses ziņojumam iespējams pievienot pielikumus;
· Elektroniskais paraksts – pazīme, kas norāda, ka e-formas e-adreses ziņojums ir elektroniski jāparaksta;
· Ģenerējamās datnes (XML, JSON) – pazīme, kas norāda, ka aizpildīto e-formu nepieciešams ģenerēt kā datni un jāiekļauj e-adreses ziņojumā;
· Fiziskām personām – e-forma pieejama fiziskām personām;
· Juridiskām personām – e-forma pieejama juridiskām personām.
Ievadīto informāciju var saglabāt, nospiežot “Save” pogu. 
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att. E-formas metadati
Ja e-formai ir paredzētas citas valodas, izveido jaunu versiju, ja tāda jau nav izveidota. Spiež uz valodas izvēli.
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[bookmark: _Ref50707750]att. Valodas nomaiņa kartītei
Atkārto 2.2 punktā aprakstīto valodas versijas izveidi, spiežot “Add new version” -> “Lock and Edit” un aizpildot e-formas metadatus.
Ievadīto informāciju saglabā, nospiežot “Save” pogu “Home” sadaļā. Izveidotās versijas versijas var pārskatīt nospiežot uz valodas pogu kā parādīts 58. att. 
[bookmark: _Toc69985615]E-formas kataloga kartītes sasaiste ar E-formu
Lai e-formas kataloga kartītei izveidotu saiti uz iestādes e-formu, ir jāizvēlas kartīte, kurai vēlas piesaistīt e-formu un tad sadaļā “PRESENTATION” izvēlēties “Details”. Parādīsies logs “Layout Details” (skat. 59. att.), kur varēs piesaistīt kartītei publicējamo e-formu.  
[image: ]
att. E-formas kataloga kartīte
Sadaļā “Layout Details” automātiski būs izveidots e-formas ietvars (layout). Nepieciešams norādīt tikai ceļu uz iestādes izveidoto e-formu. Lai veiktu konfigurācijas izmaiņas, zem SHARED LAYOUT pie Default jānospiež “Edit”.
[bookmark: Kartite][image: ]
att. E-formas konfigurēšana
Pievienot e-formas ceļu var “Controls” sadaļā. Lai papildinātu “Controls” metadatus un izvēlētos e-formas ceļu, tad sadaļā Controls->Mvc Form , jānospiež poga “Edit”. Parādīsies logs “Control Properties” (skat. 62. att.), kur būs iespēja izvēlēties ceļu uz e-formu.  
[bookmark: metadati][image: ]
att. E-formas Controls metadatu labošana
Lai pievienotu ceļu uz iestādes e-formu, jānospiež “Browse”. Parādīsies logs “Select the Associated Content”, kur būs pieejamas visas iestādes un to veidotās e-formas.  
[bookmark: control][image: ]
att. E-formas ceļš Sitecore

Izvēlas e-formu no iestādes ”published” mapes un nospiež pogu “OK”.
[bookmark: izvelne][image: ]
att. E-formas izvēlne
Izvēloties e-formas ceļu, iestatījumus nepieciešams saglabāt, nospiežot pogu “OK”.
[bookmark: cels][image: ]
att. Norādītais e-formas ceļš
Konfigurāciju var veikt arī manuāli. 
Alternatīvais veids: sadaļā “Layout Details” jāizvēlas “Edit”, lai veiktu konfigurācijas izmaiņas.
[image: ]
att. E-formas konfigurēšana
Sadaļā “Layout” no izvēlnes jāizvēlas “form Mvc Layout” ietvaru (layout). 
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att. E-formas Layout konfigurēšana
Kad tiek izvēlēts nepieciešamais ietvars (layout), tad sadaļā “Controls” jānospiež poga “Add”. Parādīsies logs “Select a Rendering”, kurā izvēlas Renderings -> System -> Forms -> Mvc Form.
Laukā “Add to Placeholder”, manuāli nepieciešams ievadīt e-formas “Controls” nosaukumu – “content” un jānospiež poga “Select”.
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att. E-formas Controls
Lai papildinātu “Controls” metadatus, sadaļā Controls->Mvc Form, jānospiež poga “Edit”. Parādīsies logs “Control properties” (skat. 64. att.), kur varēs norādīt nepieciešamās e-formas ceļu. 
[bookmark: labosana][image: ]
att. E-formas Controls metadatu labošana
Tālāk jāizpilda soļi, kas bija aprakstīti iepriekš:
1. Nospiest “Browse” (skat. 62. att).
2. Izvēlas e-formu no iestādes ”published” mapes un nospiež pogu “OK” (skat. 63. att.). 
3. Saglabā iestatījumus, nospiežot pogu “OK” (skat. 64. att.).

Abos gadījumos e-formas kataloga kartītei tiks izveidota saite uz iestādes e-formu.
[bookmark: _Toc45293662][bookmark: _Toc45803008][bookmark: _Toc46480532][bookmark: _Toc45293663][bookmark: _Toc45803009][bookmark: _Toc46480533][bookmark: _Toc45293664][bookmark: _Toc45803010][bookmark: _Toc46480534][bookmark: _Toc45293665][bookmark: _Toc45803011][bookmark: _Toc46480535][bookmark: _Toc45293666][bookmark: _Toc45803012][bookmark: _Toc46480536][bookmark: _Toc45293667][bookmark: _Toc45803013][bookmark: _Toc46480537][bookmark: _Toc45293668][bookmark: _Toc45803014][bookmark: _Toc46480538][bookmark: _Toc69985616]E-formas priekšapskate 
Lai pārliecinātos, ka visi nepieciešamie lauki tika pievienoti e-formai, jāizvēlas e-formu, tad jāieiet sadaļā PRESENTATION->Preview. 
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att. Pāreja uz E-formas priekšapskati
Tiks uzģenerēts e-formas skats, kā tas izskatīsies Latvija.lv portālā.
[image: ]
att. E-formas priekšapskate








[bookmark: _Ref50472534][bookmark: _Ref50472608][bookmark: _Toc69985617]Publiski pieejamās e-formas 
Gadījumos, ja izveidotā e-forma ir noderīga arī citiem un to var izmantot kā sagatavi arī citas iestādes, tad VRAA e-formu publicētājs var kopēt konkrēto iestādes e-formu uz “Public Forms” mapi. Visas e-formas, kuras atrodas šajā mapē būs pieejamas visiem e-formu veidotājiem ar skatīšanās tiesībām.

Lai pārkopētu e-formu uz Public Forms mapi, jāizvēlas iestādes e-formu->Copying->Copy To->Public Forms. 
[bookmark: parkopesana][image: ]
att. E-formas pārkopēšana
Formu saglabā mapē “Public Forms”. Lai e-forma tiktu pārkopēta, jānospiež pogu “Copy”. 
[bookmark: novietosana][image: ]
att. Publiskās E-formas novietošana
Iestādes e-forma ir pieejama “Public Forms”  mapē un ir izmantojama arī citām iestādēm, tas nozīmē, ka iestādes var redzēt un izmantot tās par pamatu veidojot jaunas e-formas.  
[image: ]
att. Publiskās E-forms attēlošana

Lai vieglāk būtu saprast, kura iestāde ir veidojusi e-formu, pārsauc pārkopēto e-formas failu “application”, uz e-formu ar nosaukumu “vvd_application”. Lai to izdarītu ir jānospiež uz pārkopētās e-formas->Rename, parādīsies logs, kur būs iespēja nomainīt nosaukumu.  
[image: ]
att. Publiskās E-formas nosaukuma maiņa




Lai saglabātu nosaukumu, jānospiež poga “OK”.
[image: ]
att. E-formas nosaukuma maiņa
Tiek attēlots koks ar e-formas samainīto nosaukumu. 
[image: ]
att. Publiskā E-forma ar mainītu nosaukumu

[bookmark: _Toc69985618]E-formu publicēšana
E-formas un kartītes publicēšanu veic VRAA e-formu publicētājs. Pēc e-formas publicēšanas, e-forma būs pieejama e-adresē. 
[bookmark: _Ref50474745][bookmark: _Toc69985619]E-formas kartītes publicēšana
Lai publicētu e-formas kartīti, jāizvēlas sadaļu NAVIGATE-> Open. 
[image: ]
att. Sitecore navigācijas maiņa
Atvērsies logs “Insert Item”. Izvēlas Content -> Lvp -> E-formu katalogs -> Iestādes nosaukums -> Kartītes nosaukums un spiež pogu “Insert”.
[image: ]
att. E-formu pārvaldības sadaļa
Lietotājam tiek atvērti e-formas metadati, kur nomaina kartītes stāvokli uz “Published”.
[image: ]
att. Kartītes stāvokļa nomaiņa
Saglabā izmaiņas, nospiežot pogu “Save”.
Pāriet uz sadaļu “PUBLISH”, spiež uz Publish un izvēlas “Publish item”.
[image: ]
att. E-formu publicēšana
Veic publicēšanas konfigurāciju. Visa informācija paliek pēc noklusējuma, jānospiež poga “Publish”.
 [image: ]
att. E-formas publicēšanas pārvaldība

Pēc publicēšanas konfigurācijas veikšanas, tiek parādīts publicēšanas statuss. 
 [image: ]
att. E-formas publicēšanas statuss
[bookmark: _Toc69985620]E-formas publicēšana 

Lai publicētu e-formu, atkārto e-formas kartītes soļus, “Insert Item” sadaļā izvēloties Forms -> Iestādes nosaukums -> published -> versijas mape -> E-formas nosaukums un spiež pogu “Insert”.
[image: ]
att. E-formu pārvaldības sadaļa.
Veic e-formas publicēšanu, atkārtojot 8.1 sadaļā aprakstītos publicēšanas soļus.

[bookmark: _Toc69985621]Saite uz e-formu
VRAA e-formas publicētājs pēc iestādes e-formas publicēšanas informē iestādi, ka e-forma ir publicēta un nosūta tiešo saiti uz to. 
Lai izveidotu saiti uz iestādes e-formu, VRAA e-formu publicētājam sākumā ir jāizvēlas iestādes e-formas kataloga kartīte. Lai to izdarītu jānospiež E-formu katalogs->VARAM_VVD (iestādes mape)->003_application (e-formas kartīte).
[bookmark: saite][image: ] 
att. Iestādes e-formas kartītes izvēle
Izvēloties nepieciešamo iestādes e-formas kataloga kartīti, nepieciešams nokopēt e-formas kataloga kartītes URN vērtību. Lai to izdarītu ir jāiezīmē URN vērtība un jānospiež “Copy”.
 [image: ]
att. E-formas URN vērtība
Nokopēto URN vērtību pieliek klāt saitei: https://www.latvija.lv/lv/eaddress/write?form= . Šī saite būs nemainīga, mainīsies tikai e-formas URN vērtības, jo katrai e-formai ir savs unikāls e-formas globālais identifikators.
Rezultātā tiks izveidota saite uz iestādes e-formu, kuru VRAA e-formu publicētājs nosūta iestādei tālākai izmantošanai, piemēram:
https://www.latvija.lv/lv/eaddress/write?form=URN:IVIS::EFE-003_application 
Saite ir norāde uz aizpildāmo e-formu un to izsaucot tiek saņemta informācija par adresātu, aizpildāmo e-formu, ja e-forma ir publicēta un to var aizpildīt atbilstoši e-formas iestatījumiem. Tiek inicializēta pāreja uz e-formas aizpildīšanu identiski kā gadījumā, ja lietotājs būtu manuāli norādījis adresātu un izvēlējies aizpildāmo formu no pieejamo e-formu saraksta – tiek atvērta aizpildāmā e-forma un ja formas iestatījumos ir paredzēts nodot profila datus, formai tiek nodoti lietotāja profila dati.
[bookmark: _Toc69985622]E-formas ziņojuma atpazīšana iestādes pusē

Iestāde var veidot automātisku e-formas ziņojumu apstrādi savās informācijas sistēmās. Lai atpazītu, ka ziņojums satur E-formas ziņojumu ir jāskatās eAdreses ziņojuma pielikumi. E-formas ziņojuma nosaukumi tiek veidoti pēc sekojoša principa:

<VSAA>_EFE-<īss nosaukums>-<1000000554>.(pdf, json, xml), kur:
· <VSAA> - VRAA iestāžu klasifikatorā reģistrētais iestādes “īss nosaukums” vērtība;
· EFE – e-formu pakalpojuma apzīmējums (nemainīga vērtība);
· <1000000554> - e-adreses OEAL numurs bez prefiksa OEAL (OEAL_1000000554);
· <īss nosaukums> - e-formas īsais nosaukums.

Piemēram:

VSAA_EFE-Apliecinājums-1000000554.(pdf, json, xml)




[bookmark: _Toc69985623]Aizpildīto e-formu xml un json struktūra

[bookmark: _Toc69985624]Sasaiste ar formas laukiem.

Formas lauka FieldName vērtība tiek ievietota XML un JSON Name laukā, Label vērtība tiek ievietota Label laukā, bet aizpildītā vērtība vienkāršiem tipiem tiek ievietota Value laukā.

Vispārīgi ģenerētie faili pieturas pie vienotas Label/Name/Value struktūras.
Papildus apstrāde ir nepieciešama table laukiem. (Skatīt zemāk struktūru).

[bookmark: _Toc69985625]JSON faila struktūra

JSON fails sastāv no JSON saraksta ar objektu katram aizpildītajam laukam.
Parastajiem laukiem JSON struktūra ir šāda:
{
      "Label":"<Lauka label vērtība>",
      "Name":"<Lauka fieldname vērtība>",
      "Value":"<Lauka aizpildītā vērtība>"
}

Table lauki arī ir JSON objekti sarakstā, bet to struktūra atšķiras Value laukā. Table elementiem Value lauks satur JSON sarakstu ar rūtiņas elementiem sakārtotiem pēc rindas un kolonnas. Vispārējā struktūra:
{
      "Label":"<Lauka label vērtība>",
      "Name":"<Lauka fieldname vērtība>",
      "Value":[
         {
            "Col":"<1. Kolonnas nosaukums>",
            "Row":"1",
            "Value":"<1 kolonnas 1 rindas rūtiņas vērtība>"
         },
         {
            "Col":"<2. Kolonnas nosaukums>",
            "Row":"1",
            "Value":"<2 kolonnas 1 rindas rūtiņas vērtība>"
         },
	  <patvaļīgs skaits rūtiņu>
          ,
         {
            "Col":"<pēdējās kolonnas nosaukums Kolonnas nosaukums>",
            "Row":"<Pēdējas rindas numurs(1-n, kur n ir tabulas rindu skaits)>",
            "Value":"<Pēdējas Kolonnas pēdējās rindas rūtiņas vērtība>"
         }
      ]
}

Piemērs:
[
   {
      "Label":"",
      "Name":"Text",
      "Value":"APLIECINĀJUMS"
   },
   {
      "Label":"Tel:",
      "Name":"Single-Line Text",
      "Value":"26638943"
   },
   {
      "Label":"",
      "Name":"UID",
      "Value":"270e2fd6-5f96-4b39-ac2c-578ad615d2d2"
   },
   {
      "Label":"E-pasts",
      "Name":"Email",
      "Value":"mail@mail.com"
   },
   {
      "Label":"Datums",
      "Name":"Date",
      "Value":"01.09.2020 00:00:00"
   },
   {
      "Label":"Piekrītu lietošanas noteikumiem",
      "Name":"Checkbox",
      "Value":"True"
   },
   {
      "Label":"Adrese",
      "Name":"Address",
      "Value":"Hipokrāta 11-11"
   },
   {
      "Label":"Bankas konts",
      "Name":"BankAccount",
      "Value":"LV12HABA1773737833324"
   },
   {
      "Label":"E-pasts",
      "Name":"Eaddress_Email",
      "Value":"juta.ergle@zzdats.lv"
   },
   {
      "Label":"Autorizētās personas vārds",
      "Name":"AuthorizedPersonName",
      "Value":"Custom"
   },
   {
      "Label":"Autorizētās personas uzvārds",
      "Name":"AuthorizedPersonLastName",
      "Value":"Tester"
   },
   {
      "Label":"",
      "Name":"Table",
      "Value":[
         {
            "Col":"1",
            "Row":"1",
            "Value":"Row1-col1"
         },
         {
            "Col":"2",
            "Row":"1",
            "Value":"Row1-col2"
         },
         {
            "Col":"1",
            "Row":"2",
            "Value":"Row2-col1"
         },
         {
            "Col":"2",
            "Row":"2",
            "Value":"Row2-col2"
         }
      ]
   }
]

[bookmark: _Toc69985626]XML faila struktūra

XML dokuments sākas ar standarta xml dokumenta galveni.
Formas dati ir iekļauti vienā FormData xml elementā.
Iekš FormData elementa ir Field elementi katram aizpildītajam laukam.

Parastajiem Field elementu struktūra:
<Field>
	<Label><Lauka label vērtība> </Label>
	<Name><Lauka Fieldname vērtība></Name>
	<Value><Lauka aizpildītā vērtība></Value>
</Field>

Table lauki arī ir iekš Field elementa, bet satur vairākus Value laukus. Viens Value lauks katrai tabulas rūtiņai. Atainošana ir secīgi pēc rindas un kolonnas.

Vispārīga Table struktūra:
<Field>
    <Label><Lauka label vērtība></Label>
    <Name><Lauka Fieldname vērtība></Name>
    <Value>
      <Col><1. Kolonnas nosaukums></Col>
      <Row>1</Row>
      <Value><1. Kolonnas 1. rindas rūtiņas vērtība></Value>
    </Value>
    <Value>
      <Col><2. Kolonnas nosaukums></Col>
      <Row>2</Row>
      <Value><2. Kolonnas 1. rindas rūtiņas vērtība></Value>
    </Value>
<patvaļīgs skaits rūtiņu>
    <Value>
      <Col><Pēdējās kolonnas nosaukums></Col>
      <Row><Pēdējas rindas numurs(1-n, kur n ir tabulas rindu skaits)></Row>
      <Value><Pēdējas Kolonnas pēdējās rindas rūtiņas vērtība></Value>
    </Value>
  </Field>


Piemērs
<?xml version="1.0" encoding="utf-8" standalone="yes"?><FormData>
  <Field>
    <Label></Label>
    <Name>Text</Name>
    <Value>APLIECINĀJUMS</Value>
  </Field>
  <Field>
    <Label>Tel:</Label>
    <Name>Single-Line Text</Name>
    <Value>26638943</Value>
  </Field>
  <Field>
    <Label></Label>
    <Name>UID</Name>
    <Value>270e2fd6-5f96-4b39-ac2c-578ad615d2d2</Value>
  </Field>
  <Field>
    <Label>E-pasts</Label>
    <Name>Email</Name>
    <Value>mail@mail.com</Value>
  </Field>
  <Field>
    <Label>Datums</Label>
    <Name>Date</Name>
    <Value>01.09.2020 00:00:00</Value>
  </Field>
  <Field>
    <Label>Piekrītu lietošanas noteikumiem</Label>
    <Name>Checkbox</Name>
    <Value>True</Value>
  </Field>
  <Field>
    <Label>Adrese</Label>
    <Name>Address</Name>
    <Value>Hipokrāta 11-11</Value>
  </Field>
  <Field>
    <Label>Bankas konts</Label>
    <Name>BankAccount</Name>
    <Value>LV12HABA1773737833324</Value>
  </Field>
  <Field>
    <Label>E-pasts</Label>
    <Name>Eaddress_Email</Name>
    <Value>juta.ergle@zzdats.lv</Value>
  </Field>
  <Field>
    <Label>Autorizētās personas vārds</Label>
    <Name>AuthorizedPersonName</Name>
    <Value>Custom</Value>
  </Field>
  <Field>
    <Label>Autorizētās personas uzvārds</Label>
    <Name>AuthorizedPersonLastName</Name>
    <Value>Tester</Value>
  </Field>
  <Field>
    <Label></Label>
    <Name>Table</Name>
    <Value>
      <Col>1</Col>
      <Row>1</Row>
      <Value>Row1-col1</Value>
    </Value>
    <Value>
      <Col>2</Col>
      <Row>1</Row>
      <Value>Row1-col2</Value>
    </Value>
    <Value>
      <Col>1</Col>
      <Row>2</Row>
      <Value>Row2-col1</Value>
    </Value>
    <Value>
      <Col>2</Col>
      <Row>2</Row>
      <Value>Row2-col2</Value>
    </Value>
  </Field>
</FormData>
[bookmark: _Toc50716589][bookmark: _Toc46480543][bookmark: _Toc46480544][bookmark: _Toc69985627]E-formu pakotnes sagatavošana E-formu pārnešanai 
Tiesības veikt e-formas pārnešanu ir tikai VRAA administratoram. Lai sagatavotu e-formu pārnešanai, Sitecore administrēšanas logā jāatver “Desktop” sadaļu. 
[image: ]
att. Sitecore administrēšanas logs
Atverot “Desktop” sadaļu, jānospiež Development Tools->Package Designer. Izpildot šos soļus, būs iespēja izveidot jaunu pakotni. 
[image: ]
att. Sitecore pakotnes pārvaldīšana













Veidojot jaunu pakotnes projektu, jānorāda galvenā informācija par jauno pakotni:
· Package Name – jānorāda nosaukums jaunajai pakotnei;
· Author – jānorāda autors jaunajai pakotnei;
· Version – jānorāda, kura versija tiks izmantota;
· Publisher – jānorāda, kas veic jaunās pakotnes publikāciju.
[image: ]
att. Sitecore pakotnes pārvaldīšana
Aizpildot galveno pakotnes informāciju, ir jāpievieno klāt vienumus sadaļā “Items dynamically”. 
[image: ]
att. Sitecore pakotnes izveide
Pievienojot vienumus, ir jāizvēlas nepieciešamā e-formas kartīte un jāpievieno to pakotnei. Jānospiež E-formu katalogs->VARAM_VVD(iestādes mape)->003_application(e-formas kartīte). Kad tiek pievienota kartīte, jānospiež pogu “Next”.
[image: ]
att. Sitecore elementa pievienošana 



Izvēloties nepieciešamo e-formas kartīti, veic konfigurācijas papildināšanu un nospiež pogu “Next”.
[image: ]
att. Sitecore elementa konfigurēšana 

Pēc konfigurācijas papildināšanas būs jānorāda pakotnes elementa nosaukums. Kad pakotnes elementa nosaukums norādīts, spiež pogu “Add”.
[image: ]
att. Sitecore pakotnes elementa nosaukums 
Pakotne sagatavota. Spiež “Close”.
[image: ]
att. Pakotnes sagatavošana
Lai tālāk izvēlētos e-formu un pievienotu to pakotnei, spiež uz “Items dynamically”ddod pakotnes elementa nosaukums nor Mvc Form.. Izvēlas Forms->VARAM_VVD(iestādes mape)->published->vvd_application(e-formas mape). Kad e-formas mape izvēlēta, jānospiež pogu “Next”.
[image: ]
att. Sitecore elementu pievienošana pakotnei
Veic konfigurācijas papildināšanu un nospiež pogu “Next”.
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att. Sitecore elementa konfigurēšana 
Norāda pakotnes elementa nosaukumu un nospiež pogu “Add”.
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att. Sitecore pakotnes elementa nosaukums 
E-forma pakotnei pievienota, spiež pogu “Close”.
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att. E-formas pievienošana pakotnei.
Lai uzģenerētu pakotnes ZIP, ir jāizvēlas sadaļa “Generate ZIP”.
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att. Sitecore ģenerē zip pakotni

Norāda pakotnes nosaukumu un nospiež pogu “Next”.
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att. Sitecore pakotnes nosaukums 
Lejupielādē pakotni.
[image: ]
att. Sitecore pakotnes lejupielāde




[bookmark: _Toc69985628]E-formu katloga sagatavošana e-formas pārnešanai 
Lai funkcionalitāte tiktu nodrošināta ir jāpārliecinās, vai vidēs, starp kurām veikta pārnešana, sakrīt iestādes hierarhijas koks. Ja iestādes hierarhijas koks nesakrīt, tad nepieciešams sagatavot Sitecore “E-formu katalogu”, izpildot punktus, kuri aprakstīti 2. nodaļā.  
[bookmark: _Toc69985629]Sitecore pakotnes pievienošanu 

Lai pievienotu Sitecore pakotni, VRAA administratoram, Sitecore administrēšanas logā jāatver “Desktop” sadaļu. 
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att. Sitecore administrēšanas logs
Atverot “Desktop”, jānospiež Development Tools->Installation Wizard. Izpildot šos soļus, būs iespēja pievienot jaunu pakotni. 
[image: ]
att. Izvēlas Sitecore pakotnes pievienošanu






Jāizvēlas pakotne. Izvēlēties pakotni var divos veidos - rakstot manuāli vai nospiežot pogu “Choose package”. Kad pakotne tiek pievienota, nospiež pogu “Next”.
[image: ]
att. Sitecore pakotnes pievienošana
Pārliecinoties, ka visa pakotnes informācija ir korekti ievadīta, jānospiež poga “Install”. 
[image: ]
att. Pakotnes informācija




Kad pakotne ir uzinstalēta, jārestartē Sitecore klientu. 
[image: ]
att. Sitecore klienta atjaunošana
Kad tiek pabeigta pakotnes augšupielāde, VRAA administrators, pārbauda e-formu. Pārliecinās, ka e-forma un e-formas kataloga kartīte ir pārnesta korekti. To var pārbaudīt, izvēloties E-formas katalogs->VARAM_VVD (iestādes mape)-> 003_application (e-formas kartīte).
[image: ]
att. E-formas kataloga kartīte
Lai pārbaudītu, kā izskatīsies e-forma, jāizvēlas sadaļa PRESENTATION->Preview.
[image: ]
att. E-formas priekšskatīšanas atvēršana





Tiks uzģenerēts e-formas skats.
[image: ]
att. E-formas priekšskatīšana 
Veic e-formas publicēšanu, aprakstīts nodaļā 8. E-formu publicēšana.  
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